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Welcome
Greetings,

I hope all the information we have gathered and put into this e-book will help you to achieve the goals 
you have set for yourself.

We enjoyed creating this e-book and will continue to create many more. If you want to make sure that 
you don’t miss out on the next one, please visit our home page and add yourself to our mailing list.

If you have any ideas on great topics that you would like to see in one of our future free e-books, please 
email us on info@mci.edu.au or fill out the enquiry form on our website, and we will add it to our list.

Yours sincerely,

MCI Team
www.mci.edu.au
1300 768 550
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About Management Consultancy 
International

MCI provides organisations with three main streams of core programs that link learning 
objectives to business success:

1.	 MCI works with large and small organisations to implement internationally recognised 
standards for investing in their people.

2.	 MCI provides traineeships that lead to capability improvements at all levels.
3.	 MCI runs a suite of trainer development programs including the new Certificate 4 in 

Training and Assessment (TAA04).

MCI is a Registered Training Organisation (RTO) and partners with your team to provide government-
funded training opportunities that lead to national certificates for staff. MCI provides programs in 
customer service, sales, and frontline management that lead to higher levels of effectiveness and enable 
internal career progression.

MCI adopts a unique “building block” approach to training that allows learners to work towards attaining 
leading Australian certifications, or simply attend a range of short courses.

Our experienced team is committed to assisting your learning and development division to become a 
profit centre that adds value to the business.

To find out more about how MCI can help you to achieve your personal, professional, and corporate 
goals, please visit our website at www.mci.edu.au or telephone us on 1300 768 550.

Download free eBooks at bookboon.com
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Introduction

Introduction
The 25-Hour Day

This e-book has been written to enable you to find an additional hour in your day. By providing you with 
the skills and techniques to manage your time more efficiently and effectively, you can easily discover an 
additional hour in your day for spending with your family, or just sleeping in that bit later!

Throughout this manual, you will find practical tips and instructions to help you understand time 
management. You will discover how to utilise the technology available to you, how to make the most 
of your own productive cycles, and how to make your life more efficient by understanding how you 
spend your time, and you will understand what tasks you actually need to spend your time completing.

Let’s get started!

Fun Exercise: Dream Your Hour

1.	 Take a few moments to dream about what you will do with your extra hour. Most of 
participants draw pictures of themselves sleeping, spending time with family and friends, 
or enjoying leisure activities. How much excitement or relaxation can you slot into your 
hour?
�
�
�
�
�

Download free eBooks at bookboon.com



The 25-Hour Day

13 

Know Yourself

1	 Know Yourself
1.1	 Introduction

“We are limited, but we can push back the borders of our limitations.”  
– Stephen R. Covey

Your schedule is already packed to the brim. So how do we claim to find you an additional hour every day? 

Our aim is to teach you to push your limitations away. Your busy schedule will benefit as you overcome 
your limitations by learning how to be efficient, and by making efficiency a habit of your own. 

You need to learn about yourself to ensure that you turn the lessons of this manual into a habitual 
behaviour. You need to do a thorough self-assessment of your personality.

1.2	 Getting to Know You

There are many different types of personalities. Are you a procrastinator? Or perhaps you are a 
perfectionist. This is the time to make an honest assessment of yourself and your characteristics. Do 
not be shy – you need to pinpoint your weaknesses so that you know where to concentrate for the rest 
of the manual. We will provide you with the tools to overcome your weak areas; however, you need to 
have identified those weak areas before we start.

1.3	 Be Respectful but Honest

 Respect yourself as an individual. You will have both strengths and weaknesses, and a unique personality. 
You may wish to ask yourself the following questions:

•	 Do you procrastinate or delay things until the very last moment?
•	 Are you often late? 
•	 Do you seek perfection in minor things? Do you consider yourself a perfectionist?
•	 Do you take on more than you can handle? 
•	 Do you feel that you lack organised thinking patterns at times? 
•	 Are you distracted easily by new tasks, leaving behind a mess of half finished work? 
•	 Do you wish there were more time in the day?

Remember, identifying the issues that you have with time management will simply allow you to learn 
and grow and improve those areas that need work. It will also mean that you are now accountable for 
your decision to become better at time management.
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1.4	 Thinking Further

Do you know your objectives and goals? Do you know how to schedule your life in a manageable and 
realistic way, and in a way that means you meet those goals? If not, don’t worry. This manual will teach 
you how to do those things. We will provide you with all the techniques for overcoming your own 
personal weaknesses.

1.5	 Chapter 1: Know Yourself

You should now have begun the process of understanding your weak areas that have contributed towards 
your inefficient time management.

You should now be able to:

•	 Identify your weaknesses in regards to time management.
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2	 Follow Your Productivity Cycle
2.1	 Introduction

“Even if you’re on the right track, you’ll get run over if you just sit there.”  
– Will Rogers

You have already begun to recognise what you need to work on in order to improve your time management. 
One of the simplest methods is to schedule tasks at an appropriate time of the day for you. Are you a 
morning person? A night owl? How does your energy dip throughout the day, and how do you best 
schedule your time to account for your energy levels?

2.2	 Know Your Energy Cycle 

Feeling your energy levels rise or fall is a personal observation. By using these observations, you will 
know how productive you can be during a given period of the day. Some people are at their best in the 
morning, others warm up to tasks, and some function their best at night. 

To make a big difference in your time management, you should consider your energy cycle as you plan 
your schedule. You will need to consider the activity, its importance, and the time constraints involved. 
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For example, if you are planning an important meeting and need to be mentally alert, it is best to schedule 
less demanding tasks after the meeting so that are fresh for the meeting, and so that you do not have to 
go from the demands of the meeting to the demands of another mentally challenging task.

2.3	 Mr Example’s Energy Cycle

2.4	 Your Productive Cycle

Planning your schedule according to your energy cycle is an effective way of maximising your efficiency. 
A tired mind or body can be the cause of mistakes, misunderstandings, or simple errors that cost time 
and money. 
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Unlike meetings or presentations, you are not required to be mentally alert for getting your haircut or 
sorting through your briefcase. Therefore, it makes sense to schedule those non-core activities at your 
low energy points for the day

You could also schedule more mundane tasks in order to make the most of “passive thinking sessions.” 
Your mind can contemplate a problem whilst you perform other tasks or simply relax. The term “sleep 
on it” originated from this concept, where the brain passively processes an idea while the body relaxes. 

Passive thinking can solve problems and inspire creative ideas. Therefore, letting your brain relax before 
an important meeting may not only ensure that you are alert, but it may also help you to be innovative 
and see more solutions.

2.5	 Chapter 2: Follow Your Productivity Cycle

You should now have an understanding of the high and low points for your energy during the day, and 
how to best schedule your tasks to make the most of these times, including ample passive thinking time.

You should now be able to:

•	 Chart your energy/productivity cycle.
•	 Schedule your day according to that cycle.

Exercise 2: Chart Your Energy Cycle

1.	 On the following diagram, chart your own energy cycle. Do you have a lot of energy in the 
morning? Do you slump after lunch? Do you get a mid afternoon kick when you snack?
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3	� Technology & Time 
Management
3.1	 Introduction

“Anyone who has lost track of time when using a computer knows  
the propensity to dream, the urge to make dreams come true and  

the tendency to miss lunch.”  
– Tim Berners-Lee

Is technology a time saver or a time waster in your opinion? Technology can be an excellent way to 
save time and increase your effectiveness throughout the day. However, it can also be an information-
overloading trap! Have you ever lost track of time when surfing the internet? It’s quite easy to lose hours 
a day on technology and gadgets!

3.2	 The Internet 

Beware of the internet! It can be extremely useful, but also extremely wasteful! We can easily be carried 
away looking for information on the internet. Many of us sign up to a variety of newsletters and blogs. 
However, the result is usually information overload as well as a mailbox full of spam. Ask yourself before 
you sign up to ANY newsletter or feed if you really need the information offered. Do you have the time 
to read it? Do you want to spend your time clearing out your mailbox? 

While email is a necessity in the fast moving society, keeping a single mailbox, and keeping it tidy, is often 
the least time-consuming way to manage your email communication. Using multiple mobile phones, 
laptops, desktop computers, and diaries mean that you will be spending a lot of time maintaining them. 
You want to focus on your goals, not on being organised. 

Microsoft and the University of Illinois recently undertook a study that confirmed that email use reduces 
productivity. The subjects of the study took an average of 15 minutes to return to work after receiving an 
email, as rather than immediately returning to their task, they replied to other emails or used the internet.

A study across the US, UK, and Germany by Clearswift Limited showed that 40% of employees spend 
more than one hour on personal email during work hours, every day. 50% of employees spend around 30 
minutes each day, and the remaining 10% claim to have never used business email for personal matters. 

Technology and gadgets are timesavers if used with a purpose; however, when they become a source of 
entertainment during your work hours, your time management plan can quickly be ruined. 
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3.3	 Determine Your Priorities

Author Stephen R. Covey says to plan effectively; “the key is not to prioritise what‘s on your schedule, 
but to schedule your priorities.” 

All tasks on your schedule must live up to the SMART criteria. That is, they must be:

S = specific
M = measurable
A = achievable
R = realistic
T = time-linked

All tasks should aim toward a specific goal and be measurable. You should be able to pinpoint when a 
goal is achieved. 

Aim high, but keep reality in mind. Lofty goals look good, but to manage your time effectively, you need 
realistic and achievable goals. These goals should be time linked, whether over minutes, hours, days, or 
even years. However, your schedule should cater to the specific timeframe that you are aiming at. 

3.4	 The Urgent/Important Matrix

To understand your priorities more clearly, tasks can be divided into categories that help you gauge their 
precedence. This is called the Urgent/Important Matrix. 
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3.5	 Urgent but Unimportant

These are duties you need to take care of swiftly but are unimportant in the context of your higher goals. 
A common mistake is to let such tasks take up more time than they deserve. The best way to deal with 
them is to delegate them to others whenever possible and save your time for more important matters. 
However, if you are unable to pass them over to someone else, it is best to handle them in a brisk manner, 
saving time for important tasks whilst giving these just enough attention so that they are complete. 

3.6	 Urgent and Important

When an important task is urgent, it has to be tackled quickly and efficiently. Such tasks are crises. 
Crises can bring out the best in some, whereas some individuals find it overwhelming. It is important 
to remain logical when you are dealing with a crisis and make sure that work in a systematic manner 
so that you do not make any errors. 

An effective way of preventing crises is to prioritise your Important but Not Urgent tasks to be completed 
second in line only to Urgent and Important tasks. That way you can complete tasks before they turn 
into crises.
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3.7	 Important but Not Urgent 

Along with occasional crises, these should be the focus of your schedule. Neglecting these can lead to 
time management crises such as having to deal with multiple urgent and important tasks at one time. 
Therefore, divide these tasks into manageable portions and action them in order to keep them from 
becoming urgent, and thus entering the crisis zone. 

3.8	 Neither Urgent nor Important 

These are the major time-wasters, since they threaten to divert your attention from the important and 
urgent tasks. 

The four Ds for dealing with unimportant non-urgent tasks:

•	 Do them
•	 Delegate them
•	 Dump them
•	 Defer them

The choice depends on the nature of the task; however, make the choice swiftly so you do not spend 
more time than necessary on these distractions.

3.9	 Further Notes on Your Priorities 

Remember that there is enough time in every day to complete your tasks. You just need to be careful 
of the tasks you take on. Unless a task is urgent and important, it is not always worth neglecting other 
tasks. Depending on the task, there are responsibilities you can defer or break into smaller chunks until 
they become important in nature themselves. 

3.10	 Begin with a To-Do List 

To–do lists are not a new concept in management; even people who are unaware of management principles 
make lists to aid their memories. However, for effective time planning, the schedule you create has to be 
systematically thought out by deciding the priority of your tasks before creating your list. 

A common mistake people make is to rely on their memory. This wastes time! Simple take half an hour 
per week to devise your schedule, and keep it handy at all times. Creating effective to-do list saves time 
as you do not move randomly or try to remember what to do next. 

An effective to-do list is not a wish list. It is realistic, and it keeps your motivation level high enough so 
that you want to move from one task to another. Motivation is easily dulled by overly ambitious to-do 
lists that create a regular pattern of failing to meet your goals.
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This is the point that technology becomes a time saver. To-do lists can be far more effective if you are 
using the technology available to you in the manner for which is was designed. One of the greatest tools 
available to the majority of people is Microsoft Outlook. 

3.11	 Chapter 3: Technology and Time Wasters

You should now have an idea about the pitfalls of technology, and the ways in which you can prioritise 
your tasks to create a realistic, achievable, and motivating to-do list.

You should now be able to:

•	 Identify your goals according to the SMART principles.
•	 Prioritise your tasks according to the Urgent/Important matrix.
•	 Create effective to-do lists and schedule your time.
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4	 Time Saving Tips with Outlook
4.1	 Introduction

“Don’t agonize. Organize.” 
– Florynce Kennedy

As already discussed, technology can be a time waster, or it can save time. One of the best tools, when 
utilised correctly, to save time in the office is Microsoft Outlook. It’s time to learn how to use this fantastic 
tool, with all of its functions, to facilitate your time management.

4.2	 The Outlook Site Map

Outlook contains a range of folders: Calendar, Tasks, Inbox, Contacts, Notes, and Journal. These folders 
can be simplified into the categories of Time & Activities, People, and Other Folders.

4.3	 Time & Activities

Calender: Involves the management of your meetings and time-bound 
commitments. Support your organisation and planning skills by viewing your 
calendar in the daily, weekly, or monthly view to get a clear understanding of 
your schedule, workload, and availability.

Tasks: Allows you to manage your flexible commitments and tasks. View tasks 
in a way that can be used as your daily ‘to-do’ listing.

4.4	 People

Inbox: This is the arrival point for email. All the messages that you have received 
(when not filed into a different folder) are stored here. You can set up folders 
and sub-folders to store emails and to manage your inbox effectively.

Contacts: Also known as your address book. This enables you to manage the 
contact details and communicate with key people effectively.

4.5	 Other Folders

Notes: This is an electronic version of yellow post-it notes. However, they will 
never be lost! Create notes to yourself and track or record information that is 
not linked to a particular activity or contact.
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Journal: This is an advanced way of logging what you do in Outlook. Some 
network administrators disable this tool as it consumes a large amount of disk 
space.

4.6	 A Closer Look at the Task Function

The tasks tool is the most underutilised function within Outlook. This may be because people have not 
learnt to use it effectively, or because the default settings do not necessarily enable you to see enough 
useful information about your tasks. 

However, Outlook provides a simple way to configure your screen views to better suit your needs. Firstly, 
we need to create a task so that you can see the difference in the appearance of Outlook.

4.7	 Create a New Task

1.	 Click on the Tasks folder on your folder list
2.	 Click File, New, Task and a new task form will open
3.	 Enter a Subject. Use action words e.g. – call, arrange, meet
4.	 Enter all State Dates as today, then assign a Due Date and Priority of your choice
5.	 Click Save and Close

4.8	 Change the Task Folder View

By activating the Advanced toolbar, you obtain the ability to change the way that Outlook appears (known 
as views). Your options for the appearance of Outlook will depend upon the folder you are currently using. 

To add the Advanced toolbar to Outlook, right-click anywhere in the toolbar area at the top of the 
window. Then choose Advanced from the drop down menu.

When you’re in the Tasks folder, you will now be able to see your tasks by when they were started, when 
they are due, their priority level, and what tasks are related to the same category that you have selected 
for them.

From the Tasks folder, click: 

•	 View
•	 Current View
•	 Customise Current View
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From the Tasks folder, click:

•	 View
•	 Arrange By
•	 Current View
•	 Customise Current View

1.	 The Customise View box will open
2.	 Click Fields to display the Show Fields box
3.	 In the Available Fields dropdown selection, chose All Task Fields
4.	 Double click the field names on the left so that they will be added to the box on the right. 

The fields shown on the right will appear in your Tasks Folder
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5.	 Chose the following fields in this order:
a)	 Icon
b)	 Complete
c)	 Owner
d)	 Priority
e)	 Subject
f)	 Start Date
g)	 Due Date
h)	 Date Completed
i)	 Categories

6.	 Use the Move Up or Move Down buttons to place them in the proper order as above
7.	 Click OK
8.	 Click on Group By in the Viewing Summary screen.

9.	 In the Group Items By option box, select Complete, Ascending, this will in future move 
completed items to the end of the list

10.	 Click OK
11.	 Click Sort, and in the Sort Items By option box select Due Date, Ascending. Your list will 

now start with the most current incomplete task
12.	 Click OK, OK to return to your view in the Tasks Folder

4.9	 Customise the View of Daily Tasks

By applying the customised view given below, your tasks will be grouped together by priority, allowing 
you to sequence each task in order of importance and display the working status of each task or delegation 
at a glance. While this can be a tedious task in itself, you will only have to do it once and you will reap 
the rewards of your efforts immediately. Please follow the steps carefully.
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Customise the To-Do Bar

1.	 From your Day Calendar view, click View
2.	 Select To-Do Bar and make sure only the following are checked:

-- Normal
-- Date Navigator
-- Task List

Note: Appointments should not be checked
3.	 Left click and hold on the vertical field separator between the Calendar and the To-Do Bar. 

Drag your cursor to the centre of the screen and release. You should now have three months 
of the Date Navigator visible at the top of the To-Do Bar

4.	 Beneath the Date Navigator in the To-Do Bar, place your cursor in the blank space to the 
right of the field Subject and right click once

5.	 Select Customise Current View
6.	 Click Fields, then select All Task Fields in the drop-down menu
7.	 Using the Available Fields list on the left and the Add/Remove buttons, ensure that the list 

contains the only following fields (in order):
•	 Subject
•	 Complete
•	 Status

•	 Due Date

8.	 Click OK
9.	 Click Group By

10.	 In the Group Items By option box, choose Complete, Ascending, and do not check Show 
Field in View

11.	 In the Then By option box directly below, choose Priority, Descending and again, do not 
check Show Field in View

12.	 Click Sort
13.	 In the Sort items by option box, choose Subject, Ascending
14.	 Click on Filter > Advanced
15.	 Under Define More Criteria, click Field > All Task Fields > Start Date
16.	 Set the Condition as On or Before
17.	 Type in the Value as Today
18.	 Click OK, OK to view your newly customised To-Do Bar.
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Customise the Task Pad View 

Return to your Calendar Folder:

1.	 From the Day Calendar view, right click on the grey column heading adjacent to the 
TaskPad heading

2.	 Select Customise Current View
3.	 Click Fields
4.	 Click on Status from Available Fields
5.	 Click Add->

Using the Add/Remove buttons, ensure that the list contains the only following fields (in order):
•	 Subject
•	 Complete

•	 Status

•	 Due Date

6.	 Click OK
7.	 Click Group By. 
8.	 Uncheck the box for Automatically Group According to Arrangement.
9.	 In the Group Items By option box choose Complete, Ascending, and check Show Field in 

View
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10.	 In the Then By option box directly below, choose Priority, Descending, and do not check 
Show Field in View

11.	 Click OK
12.	 Click Sort
13.	 In the Sort Items By option box choose Subject, Ascending
14.	 Click OK twice to return in your Calendar with TaskPad View.

4.10	 Customise the Inbox

Remember the four Ds for dealing with unimportant and non-urgent tasks? Do them, delegate them, 
dump them, and defer them. You can integrate this into Outlook by customising the Inbox view so that 
the contents are presented effectively. 

One way to achieve this is to turn off the Reading Pane and the Auto Preview function. Do this by:

1.	 Ensure that you are in your Inbox
2.	 Go to View > To-Do Bar
3.	 These items should be checked as Active:

-- Normal
-- Date Navigator
-- Task List

4.	 Return to View
5.	 Turn OFF Auto Preview
6.	 Turn OFF Reading Pane

1.	 Ensure that you are in your Inbox
2.	 Go to View
3.	 Turn OFF Auto Preview
4.	 Turn OFF Reading Pane
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4.11	 Convert an Email to a Task

Using your Inbox to create your To-Do list is an effective method of clearing your inbox each day. 

1.	 Close the message and go to your Inbox
2.	 Right-click on the message and while holding the right mouse button down, drag it to the 

Tasks folder in the folder list and release it
3.	 Select, Move Here as Task with Attachment and a task dialogue box will open
4.	 Edit the Subject line to indicate the action required
5.	 Set Start Date and Due Date
6.	 Set the appropriate Priority
7.	 Click the checkbox for Reminder and enter accordingly
8.	 Click Save and Close

Note: When using the Move Here… command in Step 3, you set up the task and eliminate the message 
from your Inbox at the same time. Additionally, any attachments to the email message will appear in 
the icon on the Task Form. The new task will appear on your To-Do Bar or your TaskPad on the date 
you selected as the Start Date. Once you have completed the task, should you wish to store the email, 
you can still do this by opening the attachment (from the task), then click on the Office Button, Move, 
Copy to Folder. The email will be stored here even if the task is deleted.

4.12	 Use Task Request for Delegation

 Effective delegation develops staff that are ultimately more fulfilled and productive, and it enables a 
manager to concentrate on strategic matters. Always make sure that you’ve discussed to benefits of using 
Task Request delegating with your colleagues before you implement this.

Once the manager enters information into the Task Request, automatic emails keep them updated on 
the status of the task. The recipient does not have to re-enter any of the details of the assigned task as 
this is automatically placed on their TaskPad.

Let’s use an example for this tool. I have asked Chris Harris to compile the end of month reports – usually 
my task – as I will be on leave and unable to complete the task myself.

In the Task Folder – 

1.	 Click File, New, Task Request
2.	 In the To box, type Chris Harris
3.	 In the subject box type End of Month Reports
4.	 Do not enter in a Start Date, as that is best left to the recipient
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5.	 Enter a Due Date so that Chris is aware of the deadline
6.	 Select a Priority Level
7.	 Within the notes section, make appropriate notes in regards to the task and delegation
8.	 Click Send

Note: By leaving the two boxes, Keep an Updated Copy of this Task on My Task List and Send Me 
a Status Report when this Task is Complete, you will keep a copy of the task on your own list, with 
Chris Harris noted as the owner. This means you will receive email notification of any action taken that 
relates to this task. This provides a reminder for you to follow up on the progress of the task. (Please 
note, this is only available in an IT network environment.)

4.13	 Making the Most of the Calendar

Your calendar enables you to manage your meetings and time-bound commitments, just like a normal 
diary or organiser. A quick look at your calendar should give you a thorough idea of your schedule for 
the next day, week, and month.
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4.14	 Block Out the Calendar

To effectively manage your time and reduce interruptions, it is advisable that you schedule blocked out 
periods within your Calendar for important activities and priorities. To do this from the Calendar / 
TaskPad view:

1.	 Use your cursor to highlight the period on your daily calendar (it will turn blue)
2.	 Click on the task on your TaskPad that you want to schedule and while holding the mouse 

button down, drag it onto the highlighted area on your calendar and release
3.	 Click Save and Close
4.	 Your task is now scheduled as an appointment with yourself

Notice that the task remains on your TaskPad and will do so until you check it off as complete.

4.15	 Schedule a Meeting

From time to time, you will set up tentative appointments within your Calendar that will need to be 
updated as the participant’s availability is confirmed and the requirement for additional attendees is noted.

To update your Calendar / Appointment:

1.	 From the Calendar folder, use the data navigator to click on the tentative appointment
2.	 Double click on the appointment to open the appointment details
3.	 Change Show Time As: from Tentative to Busy

To invite additional attendees to this same meeting:

1.	 Click the Scheduling tab, then click the Add Others 
2.	 Double click on the required attendees to copy them into the Required to attend box. 
3.	 Click OK

Note: If you were to include others for information or for courtesy and their attendance is not 
required to achieve the meetings objectives, enter them into the Optional box

4.	 Each participant will receive an email invitation to the meeting, which can be Accepted, 
Declined, or Accepted Tentatively. 

5.	 Click Send and each person will receive an email invitation to the meeting
6.	 If you wish to check the status of your invitations, double click on the meeting, click on the 

tab Attendee Availability and select Show Attendee Status and you will be able to review 
the individual responses. (2003 users can simply click on the Tracking tab.)

Note: This scheduling information for invitees is only a function available for contacts within a networked 
IT environment and is not available when creating appointments for recipients through email.
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To use autopick:

For IT environments which are networked (Microsoft Exchange Server), the utilisation of the AutoPick 
Next button will assist you by selecting the next available free time for all of the invitees that have been 
included in your meeting.

Schedule a recurring meeting 

To minimise the amount of time you spend creating regular appointments and meetings, you can use 
the Recurrence function in the appointment form. By clicking on this button, a new options box will 
launch that allows you to choose the frequency for an appointment that will be applied to the request 
and be set to repeat automatically.

1.	 Click File, New, Appointment
2.	 In the subject box enter the subject of the meeting
3.	 Click Recurrence
4.	 Enter a Start and End time
5.	 Select the Recurrence Pattern (for example, every Monday)
6.	 In the Range of Recurrence field select No End Date
7.	 Click OK
8.	 Check the Reminder and advance notice you want
9.	 Click Save and Close.

4.16	 Sharing Calendars

This functionality is only available for users connected to a network or Microsoft Exchange Server.

Share a public or private folder using permissions

1.	 In the Folder List, right-click the private or public folder that you want to share, then on the 
shortcut menu, click Properties (note that the owner of the public folder will have had to 
set sharing permissions)

2.	 Click Permissions tab
3.	 Click Add
4.	 Enter the name of the person you are granting access to (in the Type Name or Select from 

List box)
5.	 Click Add followed by OK
6.	 In the Name box, click the name of the person you have just added
7.	 Choose the settings you want to apply under Permissions
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Giving someone delegate access to share private folders

1.	 Tools menu, click Options and then Delegates tab
2.	 Click Add
3.	 Enter the name of the delegate you are allocating access to (in the Type Name or Select 

from List box)
4.	 Click Add then OK
5.	 Click Permissions and click on type of permission for each Outlook folder you want the 

delegate to access
6.	 Select required options

Note: If you have appointments in your shared Calendar that may be of a sensitive nature, such as HR 
Meetings / Exit Meetings or even a personal Doctor’s appointment, you will need to click the Private 

 button. That will lock the appointment and simply show as Private when viewed by anyone other 
the owner.
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Viewing someone else’s calendar 

1.	 Click on the Calendar icon on your Navigation Pane
2.	 Click the Open a Shared Calendar link
3.	 Enter the Name or click the Name button to select
4.	 Click OK

From the first time you open this other calendar, the owner’s name will be listed under the Other 
Calendars Bar.

Management of multiple calendars

Of particular benefit to those in Personal Assistant roles, the viewing of multiple calendars was introduced 
in Outlook 2003.

1.	 Right-click on the Calendar folder from your Folder List
2.	 Click New Folder
3.	 Enter what you want to name this calendar (e.g. Team)
4.	 Click OK

Note – With both Calendars open together, you can drag and drop appointments from one calendar to 
the other. Use a right mouse click to move or copy the original appointment.

4.17	 Colour Code the Calendar

Using Categories in Outlook 2007 and Labels in 2003 is an excellent visual cue to an appointment (or 
location). For example, if you travel on a very regular basis, you might want to apply a certain colour to 
each location so you can easily identify when you will be when viewing your calendar.

1.	 Open a New Appointment form in Calendar
2.	 Click on Categorise on the features button
3.	 Select All Categories
4.	 Click on the Green Category and then Rename
5.	 Rename the Green Category Adelaide (for example)
6.	 Click OK

From here on, any new appointment created in this category will be coloured green, allowing you to 
instantly see that you will be in Adelaide on this day.
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1.	 Open Calendar View
2.	 From your menu, click Edit, Label, Edit Labels
3.	 You’ll now see the pallet of colour choices. Select green and change its description to 

Adelaide.
4.	 Click OK

4.18	 Chapter 4: Time Saving Tips with Outlook

 You should now have an idea about the pitfalls of technology, and the ways in which you can prioritise 
your tasks to create a realistic, achievable, and motivating to-do list.

You should now be able to:

•	 Convert an email to a task.
•	 Share calendars and colour code them.
•	 Delegate tasks to a colleague.
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5	 Organise Outlook
5.1	 Introduction

“A man with a watch knows what time it is.  
A man with two watches is never sure.”  

– Segal’s Law

Now that you’re using Outlook to help you be more organised, why don’t take it an extra step and organise 
Outlook so that it’s working at its maximum capacity? You can easily set up rules that will automatically 
sort your lower priority emails and file them into a folder that you have previous identified and can give 
your attention to at a later stage of the day / week. You can also set Outlook to colour the incoming 
e-mails that you know you should give your attention to ASAP (like the boss!)

5.2	 Set Up Folders & Subfolders

One of the best feelings is to have a clear inbox. However, as it’s necessary to retain emails for future 
reference, a logical way to do this is with the creation of folders and subfolders.
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1.	 Right-click on Personal Folders, or your mail folder if you are on a network
2.	 Choose New Folder
3.	 Enter the name Team
4.	 Click OK
5.	 Right click on the new folder Team
6.	 Choose New Folder
7.	 Enter the name of a specific team member, for example Amy
8.	 Click OK

Note: All items contacted within your Inbox and Folders / Sub-Folders contribute to your mailbox size 
and may impose on your limit.

When connected to a network environment, storage space provided by servers can be limited as well 
as automatic settings that purge email messages, tasks, and appointments. To avoid these problems you 
may have the capability to create your own personal folders on your local hard drive, freeing up space 
on the network server. To understand policy and restrictions that may be in place by your IT Team, it is 
recommended that you contact your network administrator for further assistance in this area.

5.3	 Create a Rule

If you are on the receiving end of a large number of CC: emails, you may wish to create a rule that 
transfers these to a special folder to be reviewed later.

1.	 Right click on the top folder, Mailbox [your name]
2.	 Select New Folder
3.	 Enter the name of the new folder as Inbox CC Mail
4.	 Insure that the Folder Contains: Mail and Post Items
5.	 Highlight Mailbox [your name] under Select Where…
6.	 Click OK and the Inbox CC Mail folder should be directly above your Inbox
7.	 Open your Inbox
8.	 From the Tools menu, click Rules and Alerts
9.	 Click the New Rule button

10.	 Click on Check Messages When They Arrive
11.	 Click Next
12.	 Check Where My Name is in the CC Box from the top window pane
13.	 Click Next

14.	 Check Move it to the Specified Folder. In the Rule Description box below click the link for 
Specified and your entire folder list will appear

15.	 Click on Inbox CC Mail to highlight and click OK
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16.	 Click Next and check Except if from People or Distribution List 
17.	 In the Rule Description box below click the link for Except if From… select your 

manager(s) so that all their emails will remain in your primary Inbox
18.	 Click Finish, Apply, OK, and your new rule is now enabled

5.4	 Colour Code Emails

Any Inbox receiving a high volume of emails can be overwhelming. To define high priority messages, 
you can colour code all messages from your manager or key customers so that they will stand out.

1.	 From the Inbox, click on and highlight an email from a sender you want to colour code
2.	 Click Tools, Organise 
3.	 In the Ways to Organise Inbox section, click Using Colours
4.	 Select Automatic Formatting (top right hand corner of that window)
5.	 Click on Add, and rename your rule (Bosses are Red)
6.	 Click on the Condition box and under on the Messages tab, click the From button and 

select the person’s name then click OK
7.	 Click on Font (choose your colour) and then click OK, OK 
8.	 Close the window by using the X in the upper right hand corner, next to Automatic 

Formatting. 
9.	 Go to your Inbox and you will only see the person that you selected with that colour

5.5	 Set Up a New Contact (from an email)

Often, you will receive an email from someone new. Anticipating the need for future communications, 
you want to set them up in your Contacts folder. 

1.	 Close the original message
2.	 From your Inbox, left click on the original message and while holding the left mouse button 

down, drag it to the Contacts folder and release it
3.	 A new Contact Record will appear automatically recording the Name, Email Address, and 

the original email message
4.	 Click Save and Close and you have set up a new contact record
5.	 To clean up your Inbox, delete or store the original message.
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Another way of creating a new contact without inserting the text of the original email is to:

1.	 Ensure that you are in your Inbox
2.	 Open the original email
3.	 Hover mouse over the Sender’s Name or Email Address
4.	 Right click
5.	 Select Add to Contacts
6.	 Enter any other required information
7.	 Click Save and Close 

Note that this method only stores a new contact; it does not transfer the contents of the email.

Use Contacts to Capture Notes

You can use your Contacts to capture and record thoughts or to-do lists that relate to a specific person. 
For example, you’ve enrolled in a course and you’ve been advised that the facilitator is going to call you 
to discuss the key objectives for the programme. You also want to advise that you have an allergy to 
seafood for catering reasons and that you need to rearrange the time for the coaching session as you 
will be interstate.

Let’s see what your Contact Card would look like in this instance: 
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Now that you have created this topic listing, when the course facilitator calls you to discuss your objectives, 
you can simply open the Contact and discuss all items at the same time. 

5.6	 Follow Up on a Contact Note

Quite often informal meetings with other people result in action items. You can manage these within 
Outlook so they never fall off the radar and actions can be completed.

For example, you had a conversation with Bradley Jackson in the lift on your way back to the office from 
lunch. Bradley is working with you on a project and has received some information that he needs to 
discuss with you when he returns from an interstate trip next Thursday. After you record this information 
as part of your notes in Bradley’s Contact Record, you would then:

1.	 Click Actions, New Task for Contact
2.	 In the Subject, note the action
3.	 Select the Start and Due Date
4.	 Change the Status option to ‘Waiting on some else’
5.	 Click Save and Close on the Task
6.	 Click Save and Close on Bradley’s Contact Record

You will be able to see this new task by clicking on Thursday 14th March (as per example) in your Date 
Navigator.

Insert Email or Document Shortcuts into Contacts

Your contact record can become a trusted place to store important notes, documents, and previous 
emails with a particular contact. 

1.	 Open a Contact Record and place your cursor in the Notes
2.	 Click Insert and choose Object
3.	 Select Create From File and click Browse
4.	 Locate the desired file and click OK
5.	 Check the Link box if available and check Display as Icon
6.	 Click OK and the shortcut will appear in the Contact notes.
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5.7	 Change the Default Opening Window

Outlook has a default setting that automatically takes you to your Inbox upon opening the application. 
This can lead to you getting stuck into your day without taking into consideration your previous plans. 
In an effort to understand your schedule, change your settings so that your default takes you to your 
Calendar and Tasks first. This way you can get a hold on your day before jumping straight in and dealing 
with your Inbox. 

1.	 Click on your Calendar folder, Day view
2.	 Select the Folder List button from your Navigation Pane
3.	 Minimise the shortcut icons by dragging them downward from the Field Separator Bar

From your Calendar:

1.	 Click Tools, Options, then the Other tab
2.	 Click Advanced Options
3.	 In the Start Up in this Folder window, browse to Calendar
4.	 Click OK to save and click OK on the Options screen
5.	 Click View > Daily Task List
6.	 Select Arrange By > By Start Date

From your Calendar:

1.	 Click Tools, Options, then click the Other tab
2.	 Click Advanced Options
3.	 In the Start in this Folder window browse to Calendar
4.	 Click OK to save, and click OK on the Options screen
5.	 Click View, expand the drop-down menu to find and click on TaskPad View
6.	 Select Active Tasks for Selected Days and you will now be able to look forward on any date 

and see the tasks scheduled for that date

Download free eBooks at bookboon.com



The 25-Hour Day

44 

Organise Outlook

5.8	 Convert Email to an Appointment

In the same way that emails can be converted into a task, they can also be converted into an appointment 
that then becomes a time-bound activity. 

1.	 Right click, hold and drag the email to the Calendar folder and release
2.	 Choose Move Here as Appointment with Attachment
3.	 A new appointment form will appear with the Subject line populated and the email 

embedded into the form as an attachment
4.	 Edit the Subject line if required and select the appropriate date and time
5.	 Click on Scheduling, add the person/s who are required to attend and your schedule times 

will be revealed
6.	 Click on the Appointment tab once again and the Meeting Request form appears with the 

To: line populated with your meeting partner’s name
7.	 Enter a note with any needed additional details
8.	 Click Send

Download free eBooks at bookboon.com

Click on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read more

By 2020, wind could provide one-tenth of our planet’s 
electricity needs. Already today, SKF’s innovative know-
how is crucial to running a large proportion of the 
world’s wind turbines. 

Up to 25 % of the generating costs relate to mainte-
nance. These can be reduced dramatically thanks to our 
systems for on-line condition monitoring and automatic 
lubrication. We help make it more economical to create 
cleaner, cheaper energy out of thin air. 

By sharing our experience, expertise, and creativity, 
industries can boost performance beyond expectations. 

Therefore we need the best employees who can 
meet this challenge!

The Power of Knowledge Engineering

Brain power

Plug into The Power of Knowledge Engineering. 

Visit us at www.skf.com/knowledge

http://www.skf.com/knowledge


The 25-Hour Day

45 

Organise Outlook

5.9	 Disable Default Reminders

 As a default, Outlook has a number of reminders, notifications, alerts, and alarms that create constant 
interruptions to your productivity. 

Turn off calendar default reminders

1.	 Click Tools, Options
2.	 Under the Calendar section of the Preferences Tab, uncheck Default Reminder
3.	 Click Apply, OK to save

Turn off task reminders

Click Tools, Options

4.	 Click the Preferences tab
5.	 Click on Task Options
6.	 Uncheck the box Set Reminders on Tasks with Due Dates
7.	 Click OK, OK to return to the Tasks Folder

Turn off email notifications

1.	 From your Inbox folder, click Tools, Options
2.	 Click Email Options
3.	 Click the Advanced Email Options button
4.	 Uncheck Play a Sound and Display a Desktop Alert.
5.	 Click OK three times to finish

5.10	 Plan to be Organised

You should schedule your planning time as a recurring appointment on a daily basis. This will finalise 
your day, allowing you to have a clear mind as you walk out the door each night. It will also save you 
from getting started the next morning without considering your schedule and plan.

1.	 Open a New Appointment form
2.	 In the Subject, type Planning
3.	 Set the Start Time as one hour before you leave the office
4.	 Set the Duration for 15 minutes
5.	 Change the Show Time As field to Tentative
6.	 Set the Recurrence as Daily, Every Weekday
7.	 Scroll to the Notes section and enter the following checklist of activities to perform within 

the allotted time.
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•	 Review calendar for today and tomorrow
-- Review appointments you had today and any action items
-- Review tomorrow’s appointments to determine any preparation necessary

•	 Review tasks for today and tomorrow
-- What are your high priority tasks that need attention before you leave today?
-- Do you have any tasks that need to be re-prioritised?
-- What new tasks have a due date for tomorrow?

•	 Schedule time for priority tasks
-- Block time on your calendar by left dragging a priority task to an appropriate time 

•	 Look over your Inbox
--  Apply the 4Ds, gauge how much time you need to clear your Inbox, and schedule this 

time before you leave the office

•	 Review your accomplishments
-- Reflect on what went well today
-- Recognise anyone who exceeded your expectations today
-- Note these achievements so that you can recall them later

5.11	 A Simple Aid to Outlook

 Most people rely upon gadgets to try to organise themselves better. However, one of the very best friends 
of an organised person is a simple pencil and notepad. You cannot get too distracted by a pencil like 
you would with a gadget. 

Carry a notepad with you wherever you go and make it a habit to use it for remembering thoughts that 
you deem important. In addition, you can record your habits and pinpoint those that have a negative effect 
on your schedule. Note down where and how you waste time, and eliminate those habits by replacing 
them with new activities that make a positive impact on your time.

Download free eBooks at bookboon.com



The 25-Hour Day

47 

Organise Outlook

5.12	 Chapter 5: Organise with Outlook

You should now have an idea how to further organise yourself and your technology by utilising more 
in-depth functions of Outlook.

You should now be able to:

•	 Convert an email to a task.
•	 Share calendars and colour code them.
•	 Delegate tasks to a colleague.
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6	� Increase Productivity with Focus
6.1	 Introduction

“Don’t be a time manager, be a priority manager.” 
– Denis Waitley

Being focused on our priorities helps us to become more productive and to achieve the tasks that actually 
matter to us. Therefore, it is important to establish our priorities for the day. We need to create a time 
management plan by establishing our goals and objectives.

6.2	 Identifying Goals

Without clearly establishing goals, even the most efficient worker can achieve nothing. Each task you 
perform during a day should be a step in the direction of achieving a bigger goal.

There are three types of goals: short-term goals, medium-term goals and long-term ones.

6.3	 Short Term Goals

These can be as small but important tasks like picking up the food on your way home or calling to 
make reservations. They may also have to do with work like getting your contacts organised, planning 
an emergency meeting etc. The effects of these are readily apparent but their importance may vary from 
trivial to vital.

6.4	 Medium Term Goals

 These goals take a longer time to achieve. For instance, securing a contract or organising an event. These 
usually span from over a few days to a few months. The results become apparent with time and they, 
like short-term goals, are usually not ends in themselves.

6.5	 Long Term Goals

 These take the longest period and, usually require an extended list of short and medium-term goals 
combined to achieve them. For instance, monthly saving that leads to a new car or house, or meeting a 
major company goal with the effort towards it spanning over years of hard work. The long-term objectives 
take a lot of persistent effort and usually have outcomes that are more lasting. 
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6.6	 Create a Time Management Plan

In order to achieve what you want, all your goals and objectives have to work in the same direction and 
aiding each other. A common mistake is haphazardly planning schedules where one effort cancels out 
the other, wasting time, energy, and money.

Many people believe they have to be active all day long to utilise their time well. What they often forget 
is that being busy all the time is not a marker of good time management, but of poor time management! 
They often end up behind schedule and miss all-important time for their families and leisure because 
they take on work indiscriminately.

The best way to plan your activities is to note what you want to achieve. Do it in writing, not just 
mentally. While ascertaining objectives is important, even more crucial is to analyse whether the goals 
you are setting are something to aim for. Some aims might look worthwhile at face value, yet a closer 
look will make it clear that your time would be better spent on other tasks that lead to results that are 
more beneficial. 

6.7	 Exercise 3: Do You Kno-w Your Goals?

 This is no easy task! Many of us have never had to actively plan our lives. Nevertheless, take ten minutes to 
consider what your goals are. Organise them into long, medium, and short-term goals and fill in the table below. 

Download free eBooks at bookboon.com

Click on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read more

http://s.bookboon.com/volvo


The 25-Hour Day

50 

Increase Productivity with Focus

The reason to order them in this way is that you might find that what you previously considered your 
short-term goals may actually be hindering your long-term goals. 

It is best to think big-picture first. This might take a few drafts before you settle on your true long-term 
goals. 

Mr Example’s Goals

Long term goals

•	 Buy house in leafy suburbia

•	 Complete a Master’s degree

•	 Put the kids through private schooling

•	 Buy hobby farm in the Hunter Valley

•	 Enter academia following a successful commercial 

career

Medium term goals

•	 Lose 10 kilograms

•	 Earn promotion at work to manager of Sales and 

Marketing division

•	 Gain contract for J-Mart marketing and sales

Short term goals

•	 Finish the marketing presentation

•	 Get car repaired

•	 Contact Brian to follow up the lunch meeting

•	 Pickup Billy from soccer this afternoon

Now it’s your turn – list your goals on the following page.

Date:

Long term goals

Medium term goals

Short term goals
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It is crucial to take time to evaluate your goals on a regular basis. Life is not static. Situations change 
and your needs as a person and as part of an organisation change.  Those changes need to be reflected 
in your goals. 

The ability to monitor goals and objectives and adjust them according to need is critical to managing 
your time. It helps you to make sure your time is being well spent.

6.8	 Thinking More on Your Goals

 Consider the outcome of your goals.  A well-formed outcome is stated in positive terms, has defined 
resources, and is under the individual’s control. In order to evaluate if your tasks have well formed 
outcomes, you have to answer to the following:

1.	 What do I want?
Ask this question about the context you are considering. State what you want in positive terms:
a)	 What do you want? 
b)	 Where do you want it? 
c)	 When do you want it?

2.	 Is this achievable?
Is it realistic to believe that any person could achieve this outcome?

3.	 What will be evidence that I have achieved my outcome?
What will let you know when you have the outcome?

4.	 Is achieving this outcome within my control?
Is it under your control, i.e. can you, personally do, authorise or arrange it?  Anything that is 
outside your control is not well formed.

5.	 Are the costs and consequences that I need to achieve my outcome acceptable?
Ensure that the outcome is worth the time, outlay, and effort involved in achieving it, and that 
impact on third parties or the environment is accounted for.

6.	 Do I have all the resources I need to achieve my outcome?
Do you have or can you obtain all the resources. Resources include:
a)	 Knowledge
b)	 Beliefs
c)	 Objects
d)	 Premises
e)	 People
f)	 Money
g)	 Time
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7.	 If I could have it now, would I take it?
Are all the costs and consequences of achieving your outcome, including the time involved, 
acceptable to you and those affected by it? This is known as ecology. Consider the costs, 
consequences, environmental and third party impact of having the outcome.

If you cannot control the resources, or if you are not in charge of the situation where you can 
use your resources to achie your goals, the task does not have a well-formed outcome.

Good time management does not mean that you need to do all the work yourself.  Therefore, 
you can mark out tasks that can be delegated so you can free up time for the more important 
things leading to your goals.

6.9	 Establish Your Priorities

 Now that you’ve considered what your goals are, the next step is to evaluate these goals to decide which ones 
take precedence over others in terms of importance.  Remember, we already talked about your tasks living 
up to the ‘SMART’ criteria.  Don’t forget to divide your tasks into the Urgent/Important to help you gauge 
their precedence.  Alternatively, you could use another system of prioritising from the ones explained below.
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6.10	 The ABC System of Prioritisation

A simple method for prioritising tasks and activities is the ABC system. This is how to use it:

1.	 In the table below, make a list of all the tasks/activities you have to complete. (For the 
purposes of this exercise, limit your list to ten items). Ignore columns 1 and 2 for now.

2.	 Now do the following in column 1:
a)	 Place an A against the most important tasks – if in doubt think about which tasks 

contribute to the key purposes of your role.
b)	 Place a B against those tasks that are less important.
c)	 Place a C against any tasks you consider unimportant.

3.	 Now, redefine all of your B’s as either A’s (important), or C’s (unimportant). Indicate the 
new category in column 2. Those appearing as A in column 1 are your most important (A1) 
tasks. Those appearing as A in column 2 are your next most important (A2) tasks.

Task Column 1 Column 2

6.11	 The Prioritisation Matrix

Using a matrix is another simple method of prioritising tasks, and is particularly effective if you find it 
difficult to prioritise using the other methods. 
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This is how to use it:

1.	 Allocate one task to each of the letters A-J in the table below:

A

B

C

D

E

F

G

H

I

J

Now, in the grid below, compare each task against the others and decide which is the most important. 
So, for example if you think that B is more important than A, insert B in the B/A square. Leave the 
partially shaded squares blank.

A B C D E F G H I J

A

B

C

D

E

F

G

H

I

J
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Now, count how many times each letter appears in the grid:

A B C D E F G H I J

Finally, return to the list of tasks on the previous page and insert a ranking in the right hand column. 
The task with the highest score in the chart above is ranked first.

All these exercises will help you separate important and urgent tasks from potential time wasters and 
will help you schedule better.

6.12	 The Pareto Principle

Pareto was an Italian who realised that 80 percent of the land in Italy was owned by 20 percent of the 
population. This principle of the 80/20 split has been found to apply in many other areas. For example, 
it is often shown that 80 percent of complaints originate from 20 percent of the problems or mistakes 
we experience.
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Very often, we find ourselves giving too much priority to tasks that aren’t urgent or important. It might 
be that they are more fun, or that they are easier or faster to complete. The Pareto principle would 
suggest that 80 percent of the value of what we do comes from 20 percent of the tasks we complete. Are 
we doing the right 20 percent?

Let’s see if our tasks follow the same pattern. Fill in the table below:

Tasks I have to complete

One-off tasks Regular tasks

According to the 80/20 rule, 20 percent of our activities form 80 percent of our productivity. The remaining 
80 percent of our activities are the ones we need to deal with quickly, delegate, defer, or dump. 

The first step in delegation is to decide what tasks need to be outsourced. Instead of taking it upon yourself 
to complete everything yourself, assign less important and unimportant tasks to your subordinates. 
A primary concern when entrusting someone with a task should be whether the person is capable 
of handling the task. Choose help wisely so as not to waste time by asking a person inept at a task to 
accomplish it. Such blunders can result in a loss of resources; dent your schedule as you try to get things 
back under control, damage your assistant’s confidence levels, and cause property and monetary losses.

While communicating your desired result is a major part of delegation, it is also important to set 
checkpoints for your assistants when dealing with complicated tasks. These ensure that the task has been 
divided into enough chunks to make things easier to correct if something goes wrong. 

Resist the tendency to forget altogether about a designated task. This will ensure your helper does not 
ignore the task. Whilst it is good to trust your helpers, checking in also ensures the task is completed 
promptly. 
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6.13	 Increase Productivity with Focus

You should now understand how setting your goals, and evaluating them against each other, will enable 
you to focus your time on achieving the things that matter to you.

You should now be able to:

•	 Explain the difference between short, medium, and long term goals.
•	 State what your goals are under each of those categories.
•	 Prioritise your tasks based on your ultimate goals.
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7	� How Do You Really Spend Your 
Time?
7.1	 Introduction

“Until you value your time, you will not do anything with it.” 
– M. Scott Peck

You cannot be effective and productive in your day if you do not have a clear idea of how you are 
spending your time. Therefore, it is important firstly to identify how you are spending your time, and 
then to identify ways of making that time more productive.

7.2	 The Time Audit 

The time-audit is a great method to work out how you really spend your time. By using a watch and 
the following table to monitor your day’s activities, you will collect vital information about where your 
valuable time resources are spent. This will allow you to evaluate how well you are managing time, and 
make some decisions on how to manage your time more effectively.

Not all tasks are equal in terms of importance, therefore it is imperative to note how much time you 
spend on each activity, being honest and accurate even when you realise that you could be spending 
your time more effectively.

You’ll use the information from your time-audit to help you make decisions about how you can improve 
and optimise your working life.

While you are doing time-audit, mark interruptions you face and how they affect your work. Note any 
deadlines you have and keep a tab on them to see if you are able to meet them or not. 

Since the time-audit will give pointers to your strengths and weaknesses, by the time you review your day 
through this log you will be able to ascertain the major challenges with regard to managing your time 
more effectively. You’ll have a snapshot of your time usage that can be used to plan your schedule further.

7.3	 Mr Example’s Time-Audit

On the following page, you will find an example of a time-audit sheet having been completed for a day 
of Mr Example. Notice how he writes in what were his target objectives the actual activities he pursued.
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Name: Mr Example Date: 5th March, 2007

Hours Objective Actual Activity/Task Status / Time to Complete 

8:00  Travel Arrived (15mins late) 

8:30 Catch-up on emails (30 mins) Coffee & email catch-up Done (1hr) 

9:00 

9:30 Meet with team (15mins)  Discuss sales objectives with 
team  

Done (1hr) 

10:00 

10:30 Prepare presentation for Client X  
(2hrs allocated)   

Begin work on Presentation for 
Client X 

Incomplete (1.5hrs) 

11:00 

11:30 Show new assistant the 
database system

Partially  
complete – needs follow up 

12:00 

12:30 Lunch meeting  Lunch meeting with Brian, 
Client 

Successful (1hr) 

1:00 

1:30 Prepare sales report for 
management meeting (3hrs) 

Cont. working on presentation 
for Client X 

Finished presentation (3.5hrs) 

2:00 

2:30 

3:00 

3:30 Went for coffee, bumped into 
Sue

 Unplanned social catch-
up(1hr)

4:00 

4:30 Leave early for dentist appt Began sales report (cancelled 
dentist appt ) 

  

Incomplete (1.5hrs) 

5:00  

5:30  

6:00 Pick up Billy from soccer practice Pick up Billy (10mins late)  

6:30    
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7.4	 Conduct Your Time-Audit

Now it’s your turn! Log the tasks that you do in the day and the time it takes you to complete each task.

Name: Date:

Hours Objective Activity/Task Status / Timeto 
Complete 

8:00    

8:30    

9:00    

9:30    

10:00    

10:30    

11:00    

11:30    

12:00    

12:30    

1:00    

1:30    

2:00    

2:30    

3:00    

3:30    

4:00    

4:30    

5:00    

5:30    

6:00    

6:30    
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When reviewing your day, what did you find were your major challenges in regard to managing your 
time more effectively?

1.	
2.	
3.	

7.5	 Tricks to Increase Your Time

There are several simple methods for increasing your time. These are:

•	 Dealing with interruptions appropriately
•	 Handling phone calls efficiently
•	 Saying no
•	 Reviewing your desk set up
•	 Communicating with effectiveness
•	 Improving your personal skills
•	 Streamlining your email communication
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7.6	 Deal with Interruptions

A famous military quote says; “No plan survives contact with the enemy.“ The best of plans fall apart 
when an emergency occurs or there is an uncontrollable interruption. The objective when dealing with 
such distractions is to minimise their effects and limit the damage.

The first step in dealing with interruptions is to screen your visitors as much as possible. This does not 
mean you should make yourself unapproachable, but make sure your visitors are not there to have a nice 
chat at the cost of your schedule. There should be a time limit for visits. Give clear pointers to visitors 
that you are busy and that you would like to get down to business as soon as possible. You can implement 
a rescue plan with a colleague, if necessary. Have someone call you, or come in with an urgent matter.

If the interruption is a colleague needing your time, it serves well to go over to the said person’s workstation 
instead. Agreeing on a quiet time with the co-worker means you keep the lines of communication open, 
without disrupting your schedule. While visiting your colleague’s workstation, remain standing as you 
talk, so that the sense of urgency shows in your demeanour. That keeps you focused on your intended 
task and suggests to your colleague that there are important things that you need to work on.

Not all situations are as easily controllable however. Crises can occur from human error. These situations 
usually add to your workload and push your schedule into chaos. The most effective way out of this is 
to reassess your priorities, attempt to delegate more tasks, or find alternate solutions to your tasks. 

7.7	 Handling Phone Calls

Calls can be one of the biggest spoilers of any schedule. It is easy to lose track of time while talking on 
the phone. Tips to keep calls productive include:

•	 Stand up while you talk so that you retain a sense of urgency to get back to tasks that are 
more important. 

•	 Keep track of the time when you talk, and remember to put a time limit on a call according 
to its importance. 

•	 Do not stretch phone calls longer than necessary. 
•	 Develop a script of how you can politely end calls.

Returning phone calls is another area that can waste time. Answering machines can be useful, since 
callers can leave messages and you can get back to them regarding the important matters. In fact, since 
discussions can digress when there is a dialogue back and forth, the use of voice mail (where appropriate) 
can help you focus and reply when you have time to do so. 
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Important calls should be planned for beforehand. Writing down the relevant points, before you call, can 
help the conversation be swift. Be clear about what you wish to discuss before you start the conversation, 
keep the points in mind when on the call, and do not digress from the topic. Calling during business 
hours means the other person will be just as busy, so getting down to the point will be easier.

The mobile phone is a major time-waster. While it can be an effective tool for communication, being always 
available is not always good for your schedule as it increases the disruptions. Whilst having a friendly 
chat is not out of the question, it is important to remember that your schedule requires discipline. Beware 
of callers that usually want to discuss unimportant topics. You may want to have these conversations in 
your leisure time, or not at all! Plan your escape route before answering the call, checking caller ID helps.

7.8	 Saying No

If you are too polite to refuse anyone requesting your time, you need to learn to say “No!” Ignoring 
previous commitments to make way for someone else’s task can ruin your schedule. While it is important 
to be polite and build rapport with our colleagues, this should not mean that you take on extra work 
without first evaluating it in a dispassionate manner, and paying particular attention to how it will 
benefit your goals. 
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When you face a situation in which you are asked to take up a task that you do not think merits you 
diverting your attention, it is best to be honest with the person requesting the task. You can let them 
know what you are occupied with and (briefly) discuss why you think that this is a better use of your 
time. In this way, the other person is able to understand your rationale for not agreeing to do the task 
and can empathise with your work schedule. 

Bear in mind to keep such discussions brief! If you are going to spend ten minutes convincing someone 
you cannot hand-deliver a file upstairs, you might as well have done the task in the two minutes it would 
have taken.

Some good ways to say no:

•	 “Would you be able to handle that situation for now? I’m really busy with [task here] and I 
wouldn’t be able to give it any attention until this afternoon.”

•	 “I understand there’s a rush to get that done; I’m working on [say task here] at the moment, 
is there any other option to make it happen?”

•	 “Now is not a good time for me, I’m flat out working on [say task here]”

7.9	 Review Your Desk Set Up

Working does not mean your work environment has to be dreary and dreadfully boring. In fact, better 
working conditions always result in a better output. A lively atmosphere keeps work from getting tedious, 
as long as distractions are minimised.

Good working conditions are not just about a lively atmosphere, however. To make your office space 
more productive, you should organise your office in a manner that makes your work flow better. 

•	 Reduce clutter by getting rid of things you do not need. 
•	 Consider where your paperwork is stored; see if you are able to find what you need without 

wasting time looking for it. 
•	 Work out the paper flow on your desk and organise it so you do not have to dig through 

piles of paperwork to get to what you need, or misplace important documents when you 
need them in a hurry. 

Filing is another important aspect of organisation in the workplace. Whilst electronic filing is supposed 
to save time, it’s imperative that you can find what you are looking for quickly, regardless of whether 
the filing method is manual or electronic. Systematic filing saves hours of drudgery of looking through 
files to find the desired documents. 
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7.10	 Good Communication Equals Efficiency

A major part of time management is getting your message through effectively to your colleagues in order 
to optimise efficiency of your workplace. You can be commanding a large team of people and yet still be 
unable to get work done properly if you cannot communicate your goals. Good communication skills 
can get you better results, even with a smaller team. 

Communication is a two way street. Listen carefully and speak clearly. Ensure you understand the 
requirements before you take up a project. Pay attention when you are being spoken to, so there is less 
need for repetition. Be precise in communicating your desires when asking for assistance. 

Some people are prone to beating around the bush when they communicate. This can leave listeners 
unclear about what is desired of them. In this case, take the extra minutes to clarify what was said, in 
order to avoid the problems caused by miscommunication.

7.11	 Improve Your Personal Skills

Stagnation can cause a loss of motivation. It is human nature to want to learn and explore more facets of 
life. While we do not want to divert our attention to subjects that are not of value to your line of work, 
it is always good to remain in touch with the latest trends in your field and keep learning new ways to 
improve efficiency. 

Attending courses to improve your skills in your field, and expanding your horizons does not come 
without a cost. The new interest, be it a class or a seminar, will lay claims on your time. Therefore, you 
need to evaluate the new interest against the task that you will push back in your schedule to see if it is 
worth the effort or not. 

Check if the knowledge you wish to acquire will be useful; for instance, if you wish to take a computer 
course because it is a new trend, make sure that you have enough time and motivation to be apply the 
knowledge in the near future. Otherwise, with the pace of the IT industry, your knowledge may soon 
become redundant and your efforts will be wasted, not to mention the time spent.

7.12	 Streamline Email Communications

•	 Adopt a company-wide system of abbreviations and acronyms to easily identify emails, and 
use the subject heading to display short messages wherever possible. Learn to speed read, or 
at least increase your reading speed. That way you can ascertain the important information 
in a shorter amount of time.

•	 Ensure that you use priority flags for urgent emails only, and avoid attaching large files. You 
can instead use an intranet or hyperlink to direct the receiver to the file.
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7.13	 How Do You Really Spend Your Time

You should now understand how to conduct a time-audit, how you spend your time on unimportant 
activities, and how to increase your time even further.

You should now be able to:

•	 Conduct a time-audit on yourself.
•	 Increase your time by effectively managing interruptions, telephone calls, saying no when 

necessary, and streamlining email communication.
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8	 25 Hour Day Conclusion
8.1	 Discovered Your Extra Hour?

“You can either take action, or you can hang back and hope for a miracle. 
Miracles are great, but they are so unpredictable.”  

– Peter F. Drucker

Throughout this e-book, Management Consultancy International has described some of the most 
common time traps that slow us down and hamper our productivity. We have discussed ways to avoid 
wasting energy on unimportant matters, how to set goals and prioritise tasks. We have also described 
strategies for making sure that your communication is as clear and effective as it can be. 

You can boost your time management skills in both your working and personal life to discover your 25 
hour day.

8.2	 Where can I find further help?

Management Consultancy International
www.mci.edu.au

8.3	 E-book Evaluation

We value your feedback! Please contact MCI if you have any feedback on this e-book.
Your feedback will be used to ensure future materials will be relevant and useful.
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